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MAX1499 EV Kit Component List
(continued)

MAX1498/MAX1499

REFERENCE | QTY DESCRIPTION
JU10-JU14 5 3 pins
JU1-JU9 9 2 pins
R1 1 | 133kQ 1% resistor (1206)
R2, R12 2 | 100kQ 1% resistors (1206)
R3-R7 5 1kQ 5% resistors (1206)
Do not install—shorted trace on PC
R8, R9 0 board (1206)
R10 1 | 500kQ potentiometer
R11 1 | 24kQ 5% resistor (1206)
R13, R14 2 | 10Q 5% resistors (1206)
TB1 1 | 0.200in two-circuit screw terminal block
TP1-TP4 4 8 pins
Ul 1 MAX1499ECJ
u2 1 [ MAX1659ESA
U3, u4 2 MAX1840EUB or MAX1841EUB
U5 1 MAX6062AEUR-T, FZFY
— 1 | PC board, MAX1499 EV kit
— 13 | Shunts

Evaluate

Quick Start

Required Equipment

Before you begin, you need the following equipment:

MAX1499EVC16 (contains MAX1499EVKIT board
and 68HC16MODULE-DIP)

DC power supply, +7VDC to +20VDC at 0.5A

Windows 95/98/2000/XP computer with an available
serial (COM) port

9-pin 1/O extension cable

Procedure

Do not turn on the power until all connections are
made.

1)

2)

3)

4)

5)

6)
7

8)

Ensure that JU1-JU8 and JU10-JU14 have shunts
installed, and that JU9 is open. See the jumper set-
tings in Table 2.

Carefully connect the boards by aligning the 40-pin
header of the MAX1499 EV kit with the 40-pin con-
nector of the 68HC16MODULE-DIP module. Gently
press them together. The two boards should be
flush against one another.

Connect a +7VDC to +20VDC power source to the
HC module at the terminal block located next to the
on/off switch, along the top edge of the uC module.
Observe the polarity marked on the board.

Connect a cable from the computer's serial port to
the uC module. If using a 9-pin serial port, use a
straight-through, 9-pin female-to-male cable. If the
only available serial port uses a 25-pin connector, a
standard 25-pin to 9-pin adapter is required. The
EV kit software checks the modem status lines
(CTS, DSR, and DCD) to confirm that the correct
port has been selected.

Install the evaluation software on your computer by
running the INSTALL.EXE program on the disk. The
program files are copied and icons are created for
them in the Windows Start menu.

Turn on the power supply.

Start the MAX1499 program by opening its icon in
the Start menu.

The program will prompt you to connect the pC
module and to turn its power on. Slide SW1 to the
ON position. Select the correct serial port, and click
OK. The program automatically downloads its soft-
ware to the module.

Component Suppliers

SUPPLIER PHONE

FAX WEBSITE

Kingbright Corporation

909-468-0500 (ext 126)

909-468-0505 www.kingbright.com

Taiyo Yuden

800-348-2496

847-925-0899 www.t-yuden.com

TDK

847-803-6100

847-390-4405 www.component.tdk.com

Note: Indicate you are using the MAX1499 when contacting these component suppliers.

MAXI
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9) Apply an input signal in the range -2V to +2V
between AIN+ and AIN-. Observe the readout on
the screen.

10) To view a graph of the measurements, pull down
the View menu and click Graph.

Detailed Description of
Software

Measurement
The Measurement tab of the evaluation software mimics
the behavior of a digital voltmeter (DVM). The status bits
are polled approximately once per second. Whenever
the Data status bit is one, the ADC result register is read
and displayed as Analog Input Code. The MAX1499
also displays the result on its own LED display.

The EV kit is not a complete DVM. Additional input scal-
ing and protection circuitry might be required.

Whenever the Measurement tab is activated, the soft-
ware offers to clear the spi/adc and seg_sel control
bits to zero if they are not already clear.

Math Processing
The evaluation software implements several math func-
tions found in physical systems. Whenever the Math
tab is activated, the software offers to set the spi/adc
control bit to one if it is not already set. The software
also offers to clear the seg_sel control bit to zero if it is
not already clear.

The evaluation software intercepts the ADC result prior
to display, calculating a new LED display value when-
ever the Measurement or Math tab is active and the
spi/adc control bit is set to one. Math results are
graphed as channel one data, alongside the raw ADC
result as channel zero data.

The Type K Thermocouple function can be used
along with a suitable cold junction connection to con-
vert a type K thermocouple's measured Seebeck volt-
age into temperature in degrees centigrade. The a0
coefficient 230 represents a cold junction temperature
of +23°C.

Control Register
The Control Register tab provides access to all control
register bits. Drop down the appropriate combo-box
and then click write.

Limit Registers, ADC Offset, ADC Result,
LED Display, and Peak

The Results, Displays, Limits tab provides access
to the two's-complement data registers. Each register
has a read button and a write button, except for ADC

MAXIW

System

RESULT1, ADC RESULT2, and PEAK RESULT, which
are read only.

Reading the ADC RESULT1 or ADC RESULT2 register
automatically updates the LED display, regardless of
the seg_sel control register setting.

Writing to the ADC OFFSET register affects ADC
RESULT1 and ADC RESULTZ2, regardless of the off-
set_call control register setting.

LED Segment Registers
The LED Segments tab lets the user turn individual
LED segments on and off by clicking them with the
mouse.

Whenever the LED Segments tab is activated, the soft-
ware offers to set the seg_sel control bit to one if it is
not already set.

The Write LED Text button translates a text string into
approximate seven-segment characters, and then
writes the character patterns to the LED display.

Graph
The evaluation software has two options for graphing
data. A graph of recent data can be displayed by
selecting the View menu and then Graph. Data can be
viewed as a time sequence plot, a histogram plot, or as
a table of raw numbers. To control the size and timing
of the data runs, activate the sampling tool by clicking
the main window's Collect Samples button.

Sampled data can be saved to a file in comma-delimit-
ed or tab-delimited format. Line numbers and a
descriptive header line are optional.

Channel zero plots raw 16-bit ADC result data. Channel
one plots LED display data, if math processing is
enabled. If extended resolution is enabled, channel two
plots raw 20-bit ADC result data.

Diagnostics Window
The diagnostics window is used for factory testing prior
to shipping the evaluation kit. It is not intended for cus-
tomer use.

Detailed Description of
Hardware

The MAX1499 device under test (Ul) is a low-power,
4.5-digit ADC with integrated LED display drivers. The
MAX6062 (U5) provides on-board 2.048V reference
voltage. See the MAX1499 EV kit schematic in Figure 7
and refer to the MAX1499 data sheet.

The EV kit includes a MAX1659 high-current 5V linear
regulator (U2) and a set of MAX1840/MAX1841 level
shifters (U3 and U4) to support the use of 3V logic.
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Table 1. Graph Tool Buttons

TOOL

FUNCTION

TOOL

FUNCTION

Show the entire available input range.

Expand the graph data to fill the window.

Show sum of the samples in tabular view.

Move the view left or right.

Sumf=e=)

Show sum of the squares of the samples in
tabular view.

Move the view up or down.

Expand or contract the x-axis.

Expand or contract the y-axis.

o

£
=
=

kean

Show arithmetic mean in tabular view:

Load data from a file.

Save data to a file.

Option to write a header line when saving data.

MAX1498/MAX1499

Option to write line numbers when saving data.

f

StdDey

>(x

Mean = —( )
n

Show standard deviation in tabular view:
—_—
\ 2
\‘nz(xz)- > %
‘ n n

Standard deviation = \“

View code vs. time plot.

View histogram plot (cumulative frequency of
each code).

View table.

m

Show root of the mean of the squares (RMS) in

tabular view:

RMS = \Z(Xz)

n

Show minimum in tabular view.

Channel 0 enable (16-bit ADC result).

Show maximum in tabular view.

Channel 1 enable (math result).

Evaluate

Show span in tabular view.
Span = maximum - minimum.

amn ¢

Channel 2 enable (20-bit ADC result).

Show number of samples in tabular view.

MAXI
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Table 2. Jumper Functions Table

System

Table 3. Stand-Alone Interface Pin

*Asterisk indicates default configuration.

MAXIW

SN Functions
JUMPER FUNCTION
POSITION ULPIN | MAX1499 FUNCTION | MAX1498 FUNCTION
Closed* | LED displays are powered by U2. 8 CLK INTREF
Jul Open | VLED must be supplied by an 9 EOC RANGE
P external power source. 10 [ DPSET1
Ju2 Closed* |VDISP = GND. 11 DIN DPSET2
Open Apply VDISP voltage at VDISP pad. 12 SCLK PEAK
Closeg+ | Banana jack AIN+ connects to AIN+ 13 DouT HOLD
U3 input pin. 30 LOWBATT DPON
Insert custom filtering between JU3
Open .
pins 1 and 2. )
: Evaluating the MAX1498
Closeg+ | Banana jack AIN- connects to AIN- The MAX1499EVKIT supports stand-alone operation of
U4 Input pin. the MAX1498; however, the evaluation software cannot
Open Insert custom filtering between JU4 be used because there is no pC interface.
pins 1 and 2. The MAX1498 is the standalone version of the
U5 Closed* | REF-=GND. MAX1499. Refer to MAX1498/MAX1499 data sheet.
Open REF- must be provided by user. Request a free sample of MAX1498ECJ.
U6 Closed* | REF+ = 2.048V from U5, MAX6062. 1) The MAX1499EVKIT must be disconnected from the
Open REF+ must be provided by user. ) 68HhC16MOD;JLE' q | h th
: 2) With power disconnected, replace Ul with the
Closed* | REF+ is bypassed by C6. !
U7 B 2P Y MAX1498.
Open C6 is disconnected. 3) C { DC v at t inal block TB1
Closed* | GLED return current flows to DVpp. ) Connec power supply at termina _OC '
JU8 GLED q | 4) Turn on the power supply. The LED display should
Open powerrseotﬂ:zecu"ent ows to externa begin indicating measurement data.
' : After replacing Ul with the MAX1498, some of the pin
Closed EFDEEE = low; LED displays are functions are different. See Table 3.
anked.
Jug
Open* LED_EN = high; LED displays are — ) Exar_nple COd_e
pen enabled. Listings 1 shows the variable declarations needed in
" - — the EV kit software. Listing 2 contains the functions
JU10- 12 Display color = red. used in the EV kit software.
Jui4 2-3 Display color = green.
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o))
(@) EHM1 499 Evaluation Software -
S-l File Optionz Yiew Help
>< Measurement | b ath I Contral Hegisterl Reszultz, Dizplay, Limitsl LED Segmentsl
< B asic Analog Input Measurement [software calculates display value if zpifadc=1]
E MOTE: Ewaluation kit iz not a DYk, Requires additional input pratection circuitry and resistor dividers.
- Reference Input
g Analog Input Code 1 2 6 9 . 6 1 8 8 REF valtage: |2.E|48
#
— [T Hold mode 1 - 2 6 9 6 0 Ov [T Use Intemal 2.048 reference
é [ Peak Detect made Collect Samples | 7 Read Status W) Fead ADC Result
2 AN Bange— rDecimal Point——— Power—————— ~5Statu

O 200my | | O 18388 = On lecons Deeh
.. o CEEGE T : rlanaie wrl-anrz
Q £ oy g 1::1? {0 Analog O Data
) i > Digital Off o e
® ) 18.888 Unlsr-Hanys
-] Reset " 1.8888 > Off
®

ow-Level Data
> Low-Level Dat
L
Command reading...
DIM 1110 1000 1111 1111
oouT o011 oooo
ADC_RESULTZ

Figure 1. MAX1499 Evaluation Software—Measurement Tab

6 MAXI
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File Options

m MAX1499 Evaluation Software

Yiew Help

Measurement  Math | Contral Hegisterl Reszultz, Dizplay, Limitsl LED Segmentsl

Software calculates display value when measurement or math tab iz active and spi/adc=1.

A0C Result: 1 2 6 9 6 - 3 7 5 LED Dizplay: 1 1 0 0
—AIN Range Linearl E!uadratin::l Cubic I Exponential Lnganthmn: TypeKThermuc:uupIeI

20wy

e oy LED = al + al *log (ADC + a2] azsuming ADC ¥ a2, othenwize -13333
~Decimal Point— Iog10)=2.303; 1/log(10)=0. 434 Fieset to al=-3000, 21=434, 22=0

" .18888

@ 18888 Coefficients;

18888

" 18888 al |-3IIIIIIIII al |434 aZ |D a3 |

" .1.8808

Low-Level Data
Command LED_DATA
DIM 1001 o010 oooo o100 o100 1100
DauT Higg Higg Higg Higg

don't care

Figure 2. MAX1499 Evaluation Software—Math Tab

MAXIW
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MAX1499 Evaluation Software
File Optionz Yiew Help

Measurementl b ath I Contral Reqister I Reszultz, Dizplay, Limitsl LED Segmentsl

Enable advanced featurez using the control register directly

zpidadc |1 dizplay LED Data Reg E hiold IEI niormal operation

extelk, IEI clock = internal clock, peak, IEI niormal operation

intref IEI external reference range IEI ifput range 2 %

dpon |1 decimal point on clr IEI niormal operation

dpset? IEI DF1/DP3 seg_szel IEI niormal operation

MAX1498/MAX1499

dpzetl IEI DF1/DF2 Aoftzet_call ID offzet determined by autnEI

pd_dig IEI digital power on offzet_cald IEI niormal operation

pd_ana IEI analog power on enable IEI LED drivers dizabled

Reszet zeral interface by clocking in 32 one's

Low-Lewel Data

Evaluate

Command reading...
DIM 1100 0010 1111 1111 1111 1111
oouT 1001 o000 oooo oooo
COMTROL

Figure 3. MAX1499 Evaluation Software—Control Register Tab

8 MAXI
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File Optionz Yiew Help
Measurementl b ath I Contral Register - Results, Display, Limits | LED Segmentsl

ﬂ MAX1499 Evaluation Software -

Over/Undemrange thresholds, ADC offset. conversion result, display. peak value

ADC_RESULTZ

Read OVERRANGE [19993 wiite
Read UNDERRANGE [-20000 wiite
Read ADC OFFSET [0 Wwiite
ADCRESULT 1 [12696.813
Read LED DATA [1100 white
Read PEAK RESULT |0
Read ADC RESULT 2 [208
Low-Level Data
Command reading...
DIM 1110 1000 1111 1111
oouT 1101 0000

Figure 4. MAX1499 Evaluation Software—Results, Display, Limits Tab

MAXIW
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o))
(@)) EHAH1 499 Evaluation Software -
: File Optionz Yiew Help
>< Measurementl b ath I EnntranegisterI Results, Dizplay, Limits | LED Seaments |
< Dnve LED segments directly
=
00)
o
v
%
2 Read all Read LED Segment Heg 1 LED Seg 1 regigter = 0000 1117 0000 0711
'q)' &l 5egrments On Read LED Segment Heg 2 LED Seg 2 regigter = 0011 0000 1007 1707
e
(ﬁ All Segments OFff Read LED Segment Reg 3 LED Seq 3 regigter = 11101001
>
T [Pass e LED e )
> Low-Level Data
LL
Command LED _SEG_3
DIM 1000 1100 1110 1001
oauT oooo oooo
don't care

Figure 5. MAX1499 Evaluation Software—LED Segments Tab

10 MAXI
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Eﬂeal Time Data - EIEI

File Optionz Length

| «lalH]>] alE
| III:

"' Top=166814. YScale=2

MM WY AR W

Max JI1EEE0Y Mean [1B6803.3287 | | StdDew |1.3807E0 J Min

ol Lad had g

"rBottom=166780, Left=0 #3cale=Z, xRight=103]

Figure 6. MAX1499 Evaluation Software—Graph
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Figure 7a. MAX1499 EV Kit Schematic (Sheet 1 of 2)
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Figure 7b. MAX1499 EV Kit Schematic (Sheet 2 of 2)
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Figure 8. MAX1499 EV Kit Component Placement Guide—Component Side
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XXX o(oqo oVvo oVvo LX) ‘

#

Figure 9. MAX1499 EV Kit PC Board Layout—Component Side
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Figure 10. MAX1499 EV Kit PC Board Layout—Solder Side
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/I Drv1499.h

/I MAX1499-specific driver.

/I mku 01/07/2004

/I (C) 2004 Maxim Integrated Products
/I For use with Borland C++ Builder 3.0
1l
/I Revision history:

// 01/07/2004: modify drv 1 4 9 4 driver to become drv1499

/1 12/04/2003: fix indentation

// 09/15/2003: add double V oltage(void)

/1 09/12/2003: add SPI_Transfer_After_EOC()

// 09/09/2003: add class MAX1499 dependent on external SPI_Interface()
// 08/13/2003: preliminary draft of reusable code

1l

#ifndef drv1499H
#define drv1499H
11

1
/I The following interface protocols must be provided by
/I the appropriate low-level interface code.

I

/* SPI interface:

*x byte count = transfer length

*x mosi[] = array of master-out, slave-in data bytes

xx miso_buf[] = receive buffer for master-in, slave-out data bytes
*/

extern bool SPI Transfer(int byte count,

/* SPI interface, with data transfer immediately after EOC is asserted:
*x byte _count = transfer length

*x mosi[] = array of master-out, slave-in data bytes
*x miso_buf[] = receive buffer for master-in, slave-out data bytes
*/

extern bool SPI_Transfer After EOC(int byte_ count,

1l
/| Define the bits in the COMMS register.
/I START R'W RSA RS3RS2 RS1RS0 0

#define MAX1499 COMMS START 0x80

#define MAX1499 _COMMS_RW_MASK 0x40

#define MAX1499 “COMMS _RW _WRITE 0x00
#define MAX1499 COMMS_RW_READ 0x40
#define MAX1499 COMMS RS _MASK 0x3E

#define MAX1499 COMMS_RS_00000 0x00
#define MAX1499 COMMS RS STATUS 0x00
#define MAX1499 COMMS_RS OOOOl 0x02
#define MAX1499 COMMS_ RS CONTROL 0x02
#define MAX1499 COMMS_RS_00010 0x04
#define MAX1499 _COMMS RS _OVERRANGE 0x04
#define MAX1499 COMMS_RS 00011 0x06
#define MAX1499 COMMS RS _UNDERRANGE 0x06
#define MAX1499 COMMS_RS OOlOO 0x08
#define MAX1499 _COMMS RS LED_SEG_1 0x08
#define MAX1499 _COMMS_RS 00101 0x0A
#define MAX1499 _COMMS RS LED_SEG_2 0x0A
#define MAX1499 _COMMS_RS 00110 0x0C
#define MAX1499 _COMMS RS LED_SEG_3 0x0C
#define MAX1499 _COMMS_RS 00111 0x0E
#define MAX1499 COMMS RS _ADC_OFFSET 0x0E
#define MAX1499 COMMS_RS 701000 0x10
#define MAX1499 COMMS RS _ADC_RESULT1 0x10
#define MAX1499 COMMS_RS 01001 0x12
#define MAX1499 COMMS RS LED DATA 0x12
#define MAX1499_COMMS_RS_01010 0x14
#define MAX1499 COMMS RS PEAK 0x14
#define MAX1499 COMMS_RS_10100 0x28
#define MAX1499 COMMS RS _ADC_RESULT2 0x28

1l
/I Define the bits in the STATUS register.
/I POL OVR_RNG UNDR_RNG LOW_BATT ADD(data available) 0 0 0

const unsigned _ int8 mosi[], unsigned __ int8 miso_buf[]);

const unsigned _ int8 mosi[], unsigned _ int8 miso_buf[]);
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#define MAX1499 STATUS_POL_MASK 0x80
#define MAX1499 STATUS POL POSITIVE 0x00
#define MAX1499 STATUS POL_NEGATIVE 0x80
#define MAX1499 STATUS OVER RANGE 0x40
#define MAX1499_ STATUS_UNDER RANGE 0x20
#define MAX1499 STATUS LOW BATTERY 0x10
#define MAX1499 STATUS DATA READY 0x08

1
/I Define the bitsin the CONTROL register.
/I SPI_ADC EXTCLK INTREF DPON DPSET2 DPSET1 PD_DIG

PD_ANA

MAX1498/MAX1499

//HOLD PEAK RANGE CLR LED OFFSET_CAL1 OFFSET_CAL2 ENABLE
#define MAX1499 CONTROL SPI ADC 0x8000
#define MAX1499 CONTROL EXTCLK 0x4000
#define MAX1499 CONTROL INTREF 0x2000
#define MAX1499 CONTROL DPMASK 0x1C00
#define MAX1499 CONTROL DPON 0x1000
#define MAX1499 CONTROL DPSET2 0x0800
#define MAX1499 CONTROL DPSET1 0x0400
/I (DPSET2 isthe LSB and DPSET1 isthe MSB)
#define MAX1499 CONTROL_DPION 0x1000 /* -1888.8 */
#define MAX1499 CONTROL DP20N 0x1800 /* -188.88 */
#define MAX1499 CONTROL_DP30ON 0x1400 /* -18.888 */
#define MAX1499 CONTROL DP4ON 0x1C00 /* -1.8888 */
#define MAX1499 CONTROL_PD_DIG 0x0200
#define MAX1499 CONTROL PD ANA 0x0100
#define MAX1499 CONTROL PD_ALL 0x0300
. #define MAX1499 CONTROL HOLD 0x0080
#define MAX1499 CONTROL_PEAK 0x0040
(1) #define MAX1499 CONTROL RANGE 200mV 0x0020
) #define MAX1499 CONTROL_CLR 0x0010
cts #define MAX1499 CONTROL SEG_SEL 0x0008
#define MAX1499 CONTROL OFFSET CALl 0x0004
3 #define MAX1499 CONTROL OFFSET CAL2 0x0002
— #define MAX1499 CONTROL_ENABLE 0x0001
CG I
/I Define the bitsin the LED SEGMENT 1 register.
> /I A2G2D2F2E2DP20B1
LIJ ZClAlGlDlFlElDPCLO
#define MAX1499 LED_SEGl Al 0x8000
#define MAX1499 LED SEGl Gl 0x4000
#define MAX1499 LED_SEGl D1 0x2000
#define MAX1499 LED SEGl F1 0x1000
#define MAX1499 LED_SEGl _E1 0x0800
#define MAX1499 LED SEGl DP2 0x0400
#define MAX1499 LED_SEGl_ B0 0x0100
#define MAX1499 LED SEGl CO 0x0080
#define MAX1499 LED_SEGl_ A0 0x0040
#define MAX1499 LED SEGl GO 0x0020
#define MAX1499 LED_SEGl_DO 0x0010
#define MAX1499 LED SEGl FO 0x0008
#define MAX1499 LED_SEGl_EO 0x0004
#define MAX1499 LED SEGl DP1 0x0002
1
/I Define the bitsin the LED SEGMENT 2 register.
/I FAE4ADP4 G4AB3C3A3G3
Z D3F3E3DP30B2C20
#define MAX1499 LED SEG2 F3 0x8000
#define MAX1499 LED_SEG2_E3 0x4000
#define MAX1499 LED SEG2 DP4 0x2000

#define MAX1499 LED SEG2 MINUS
*/

0x1000 /* TODO: is this documented?

#define MAX1499 LED SEG2 B2 0x0800
#define MAX1499 LED SEG2_C2 0x0400
#define MAX1499 LED SEG2 A2 0x0200
#define MAX1499 LED_SEG2_G2 0x0100
#define MAX1499 LED SEG2 D2 0x0080
#define MAX1499 LED SEG2_F2 0x0040
#define MAX1499 LED SEG2 E2 0x0020

minus sign
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#define MAX1499 LED SEG2 DP3 0x0010
#define MAX1499 LED SEG2_Bl 0x0004
#define MAX1499 LED SEG2 Cl 0x0002

1l
/I Define the bitsin the LED SEGMENT 3 register.

ZOOBC584C4A464D4

#define MAX1499 LED SEG3 BC 0x20
#define MAX1499 LED SEG3_B3 0x10
#define MAX1499 LED SEG3 C3 0x08
#define MAX1499 LED SEG3 A3 0x04
#define MAX1499 LED SEG3 G3 0x02
#define MAX1499 LED SEG3_D3 0x01

11
class MAX1499
{
public:
MAX1499 (void) ;

/I Enumerated type describing the register select bits.

enum RegisterSelect t {
RS_STATUS = MAX1499 COMMS RS _STATUS,
RS_CONTROL MAX1499 COMMS RS CONTROL,
RS_OVERRANGE MAX1499 COMMS RS _OVERRANGE,
RS_UNDERRANGE MAX1499 COMMS RS UNDERRANGE,
RS_LED_SEG_1 MAX1499 COMMS RS LED SEG 1,
RS LED SEG 2 MAX1499 COMMS RS LED SEG 2,
RS_LED_SEG_3 MAX1499 COMMS RS _LED SEG_3,
RS_ADC OFFSET MAX1499 COMMS RS ADC OFFSET,
RS_ADC_RESULT1 MAX1499 COMMS RS_ADC_RESULTI,
RS_LED DATA MAX1499 COMMS RS LED DATA,
RS_PEAK MAX1499 COMMS RS PEAK,
RS _ADC RESULT2 = MAX1499 COMMS RS ADC RESULT2

Y

/I Reference voltage
gouble vref;
1l
/I Status Register

/I POL OVR_RNG UNDR_RNG LOW_BATT ADD(data available) 00 0
int STATUS REG;
il -

bool Read STATUS(void) ;

1l
/I Control Register

/I SPI_ADC EXTCLK INTREF DPON DPSET2 DPSET1 PD_DIG PD_ANA
/IHOLD PEAK RANGE CLR LED OFFSET_CAL1 OFFSET_CAL2 ENABLE
/j/.nt CONTROL REG;

bool Write CONTROL(int data);
bool Read CONTROL(void) ;

11
/I Data Registers

int ADC_RESULTL1;
unsigned int ADC RESULT2;
1 -

bool Read ADC RESULTI (void) ;

bool Read ADC_RESULT2 (void) ;

long int DATA REG; [/ 16-bit or 24-bit result from A/D converter
bool extended_resolution;

long Read DATA(void);

double Voltage(void) ;

11

/I Other registers, having 16-bit 2's complement data format

bool VWrite_ 2s_complement (int reg, int data);
int Read 2s _complement (int req);
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11
1 Other registers, having 8 bit data format
bool Write 8bit reg(int reg, int data);
int Read 8bit reg(int req);

11
#endif

Evaluate: MAX1498/MAX1499
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// Drv1499.cpp

/I MAX1499-specific driver.

/' mku 09/15/2003

I/ (C) 2003 Maxim Integrated Products
Z For use with Borland C++ Builder 3.0

/I Revision history:

// 09/15/2003: add double V oltage(void)

/1 09/09/2003: add class MAX 1499 dependent on external SPI_Interface()
/1 08/13/2003: preliminary draft of reuseable code

#include "drv1499.h"

1l
MAX1499::MAX1499 (void)
{
vref = 2.048;
extended_resolution = false;

}
1

bool MAX1499::Read_ STATUS (void)
{

const unsigned __ int8 mosi[] = {
(unsigned _ int8) (MAX1499_COMMS_START |
MAX1499 COMMS_RW_READ | MAX14997COMM87R57STATUS),
(unsigned _ int8) (0xFF)
Y
unsigned _ int8 miso_buf[sizeof (mosi)];
bool result = SPI_Transfer(sizeof(mosi), mosi, miso_buf);
if (result) {
int data = miso_buf[1];
STATUS REG = data; /I remember the value we just received
}
return result;

}
11

bool MAX1499::Write CONTROL (int data)
{

data = data & OxFFFF; /I validate the data
const unsigned __ int8 mosi[] = {
(unsigned _ int8) (MAX1499_COMMS_START |
MAX1499_COMMS_RW_WRITE | MAX1499 COMMS_RS_CONTROL),
(unsigned _ int8) ( (data >> 8) & O0xFF),
(unsigned __ int8) ( data & OxFF)
Y
unsigned __ int8 miso_buf[sizeof(mosi)];
bool result = SPI Transfer(sizeof(mosi), mosi, miso_buf);
CONTROL REG = data; /I remember the value we just wrote
/I The CLR bit is self-clearing, and should not be kept high.
CONTROL_REG &=~ MAX1499 CONTROL CLR;
return result;

}
1

bool MAX1499::Read CONTROL(void)
{

const unsigned __ int8 mosi[] = {
(unsigned _ int8) (MAX1499_COMMS_START |
MAX1499 COMMS_RW_READ | MAX1499 COMMS_RS_CONTROL),
(unsigned _ int8) (0xFF),
(unsigned __ int8) (0xFF)
}i
unsigned __ int8 miso_buf[sizeof(mosi)];
bool result = SPI Transfer(sizeof(mosi), mosi, miso_buf);
if (result) {
int data = miso _buf[l] * 0x100 + miso buf[2];
CONTROL_REG = data; /I remember the value we just wrote
}
return result;

}
I

bool MAX1499::Read ADC RESULT1 (void)
{

const unsigned __ int8 mosi[] = {
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(unsigned _ int8) (MAX1499_COMMS_START |
MAX1499 COMMS_RW _READ | MAX1499 COMMS_RS_ADC_RESULTL),
(unsigned _ int8) (0xFF),
(unsigned __ int8) (0xFF)
}i
unsigned __ int8 miso_buf[sizeof(mosi)];
bool result = SPI_Transfer After EOC(sizeof(mosi), mosi, miso_buf);
if (result) {
ADC_RESULT1 = (miso buf[1l] * 0x100L) + miso buf[2];
long data = (miso_buf[l] * 0x100L) + miso_buf[2];
if (data >= 32768) {
data -= 65536;
}
DATA_REG = data; /I remember the value we just received
}
return result;

}
1

bool MAX1499::Read ADC RESULT2 (void)
{

const unsigned __ int8 mosi[] = {
(unsigned _ int8) (MAX1499_ COMMS_START |
MAX1499 COMMS_RW _READ | MAX1499 COMMS_RS_ADC_RESULT2) ,
(unsigned __ int8) (0xFF)
Y
unsigned _ int8 miso_buf[sizeof(mosi)];
bool result = SPI_Transfer(sizeof(mosi), mosi, miso_buf);
if (result) {
ADC_RESULT2 = miso_buf[1l];
long data 24 = ((long)ADC_RESULT1 * 0x100L) + ADC_RESULTZ2;
DATA_REG = data_24;
}
return result;

}
1

long MAX1499::Read DATA(void)
{

/I Read the DATA register
const unsigned __ int8 mosi[] = {
(unsigned _ int8) (MAX1499_COMMS_START |
MAX1499 COMMS_RW _READ | MAX1499 COMMS_RS_ADC_RESULTL),
(unsigned __ int8) (0xFF),
(unsigned __ int8) (0xFF)
}i
unsigned __ int8 miso_buf[sizeof(mosi)];
if (SPI_Transfer After EOC(sizeof(mosi), mosi, miso_buf) == false) {
return 0; // falure
}
ADC_RESULT1 = (miso_buf[l] * 0x100L) + miso_buf[2];
long data = (miso_buf[1l] * 0x100L) + miso_buf[2];
if (data >= 32768) {
data -= 65536;
}
DATA REG = data; /I remember the value we just received
if (extended resolution) {
/I Read the ADC_RESULT2 register
const unsigned _ int8 mosi[] =
(unsigned __int8) (MAX1499 COMMS_START |
MAX1499 COMMS RW READ | MAX1499 COMMS RS ADC RESULT2),
(unsigned __ int8) (0xFF)
}i
unsigned __ int8 miso_buf[sizeof (mosi)];
if (SPI_Transfer(sizeof(mosi), mosi, miso_buf) == false) {
return 0; // falure

ADC_RESULT2 = miso_buf[1l];
long data 24 = ((long)ADC_RESULT1 * 0x100L) + ADC_RESULTZ2;
double data 16 = data 24 / 256.0;
if (data_16 >= 32768) {
data_16 = data_16 - 65536;

DATA_REG = data_24;
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}
return DATA_REG;

}
1l

double MAX1499::Voltage (void)
{

if ((CONTROL_REG & MAX1499 CONTROL_RANGE 200mV) == 0) {
I Input range 2V
return DATA REG * (vref / 2.048) * 10e-6 * 10;

} else {

/I Input range 200mV

return DATA REG * (vref / 2.048) * 10e-6;

}
1l

bool MAX1499::Write 2s_complement (int reg, int data)
{

/I Write one of the 2's complement registers
reg = (reg & MAX1499 COMMS_RS_MASK) ;
data = data & OxFFFF; /I validate the data

const unsigned _ int8 mosi[] = {
(unsigned __int8) (MAX1499 COMMS START | MAX1499 COMMS RW WRITE
(unsigned __ int8) ((data >> 8) & OxFF),
(unsigned __ int8) (data & OxFF)

}i

unsigned __ int8 miso_buf[sizeof (mosi)];

bool result = SPI _Transfer(sizeof(mosi), mosi, miso_buf);

return result;

11
int MAX1499::Read_2s_complement (int req)

/I Read one of the 2's complement registers
reg = (reg & MAX1499 COMMS_RS_MASK) ;

const unsigned __ int8 mosi[] = {
(unsigned __int8) (MAX1499 COMMS_START | MAX1499 COMMS_RW_READ
(unsigned __ int8) (OxFF),
(unsigned _ int8) (0xFF)
}i
unsigned _ int8 miso_buf[sizeof (mosi)];
bool result = SPI_Transfer(sizeof(mosi), mosi, miso_buf) ;
if (result == false) {
return 0; //falure
}
int data = miso_buf[1l] * 0x100 + miso_buf[2];
if (data >= 32768) {
data -= 65536;

}

if (data >= 32768) {
data -= 65536;

}

return data;

}
11

bool MAX1499::Write 8bit reg(int reg, int data)
{

/I Write one of the 8 bit registers

reg = (reg & MAX1499 COMMS RS _MASK) ;

const unsigned __ int8 mosi[] = {
(unsigned __int8) (MAX1499_ COMMS_START | MAX1499 COMMS_RW_WRITE
(unsigned __ int8) (data & OxFF)

}i

unsigned __ int8 miso_buf[sizeof (mosi)];

bool result = SPI_Transfer(sizeof(mosi), mosi, miso_buf);

return result;

11
int MAX1499::Read_8bit_reg(int req)

/I Read one of the 8 bit registers
reg = (reg & MAX1499 COMMS_RS_MASK) ;

req),

reg),

reg),
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const unsigned _ int8 mosi[] = {
(unsigned __int8) (MAX1499 COMMS_START | MAX1499 COMMS RW_READ | reg),
(unsigned _ int8) (0xFF)
}i
unsigned _ int8 miso_buf[sizeof(mosi)];
bool result = SPI_Transfer(sizeof(mosi), mosi, miso_buf);
if (result == false) {
return 0; //falure
}
int data = miso_buf[1];
return data;

MAX1498/MAX1499
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